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1. Overview 

The software MobileDOAS described in this user manual is a software package developed by 

Chalmers University of Technology in Sweden as an easy to use software package for performing 

gas flux measurements using the mobile DOAS technique. 

The software is tested with the following spectrometers from Ocean Optics Inc.: 

• S2000  

• USB2000+ 

• USB2000 

• USB4000 

• HR2000 

• HR4000 

1.1 REQUIRED DEVICES 

Table 1 Required Devices 

Spectrometer Collect Spectra 

GPS receiver (with USB interface) Record GPS time and GPS coordinates 

USB cable Communication with and power to spectrometer 

Fiber and telescope Connected to the spectrometer to expand the visible scope 

Laptop or desktop computer Run the program to collect data from spectrometer and GPS 

receiver 

Before running the software, please make sure that the equipment is properly connected to the 

computer. 

1.2 COMPUTER REQUIREMENTS 

CPU Pentium III 550 MHz or higher 

Memory 128 MB or more 
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Operating system Windows XP, Windows 7, or Windows 10 

Screen Resolution 1024 by 768 pixels or better 

 

1.2.1 High DPI Displays 

MobileDOAS dialog windows may not display properly on a high DPI display.  In this case, you can 

override high DPI scaling behavior in the application’s Properties->Compatibility settings: 

1. Right Click on MobileDOAS.exe (or MobileDOAS_x64.exe) 

2. Select Properties 

3. Select Compatibility tab 

4. Check the box next to ‘Override high DPI scaling behavior.’ 

5. Select ‘System’ in drop down under ‘Scaling performed by:’ 
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Figure 1 Disabling high DPI scaling behavior 

1.3 SOFTWARE INSTALLATION 

MobileDOAS does not have an installer but require other programs to be installed as a pre-requisite 

for use: Java 8, Ocean Optic’s OmniDriver, spectrometer driver, and GPS driver. Install either the 32 

or 64-bit versions of the software depending on your OS (you can only install 32-bit on 32-bit OS) 

and the version of MobileDOAS you want to run.   

1.3.1 Java 8 

Java is a commonly used software so your PC may already have it installed.  Look under C:\Program 

Files\Java for 64-bit installation (or C:\Program Files (x86)\Java for 32-bit installation).  You should 

see jre1.8.0_xxx or jdk1.8.0_xxx in the directory.  If you do, Java is already installed on your PC. If 

you do not have Java installed on your PC download the JRE from Oracle website 

(http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html) 

and install. 

http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html
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MobileDOAS has not been tested with Java 6 or Java 7 but it may work with these older versions 

also. 

1.3.2 OmniDriver 

If OmniDriver is not provided download from Ocean Optics website 

(https://oceanoptics.com/support/software-downloads/#omnidriver) and double click on it to 

run it.  Select all default options when prompted by installer.  License to use the OmniDriver is not 

required unless you are planning to do software development against it. You should now have an 

Ocean Optics/OmniDriver directory (e.g. C:\Program Files (x86)\Ocean Optics\OmniDriver). 

If you see the error message “Error running RegAsm64.exe … : Program ended with an error exit 

code.” – then you are missing the .NET framework on your computer.  You can download the 

installer for .NET 4.0 from the Ocean Optics OmniDriver download page under Miscellaneous Tools 

and Utilities.) 

1.3.3 Spectrometer Driver 

After installing OmniDriver, connect your spectrometer to the computer.  Then go to Control Panel -

> Device Manager.  Look for your spectrometer under “Ocean Optics USB Devices”. It is also possible 

that your computer does not recognize the device and it will be under “Other devices” as an 

“Unknown device” 

 

Figure 2 Ocean Optics spectrometer in Device Manager 

https://oceanoptics.com/support/software-downloads/%23omnidriver
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Figure 3 Spectrometer listed as "Unknown device" 

Right click on the spectrometer name (or “Unknown device” depending on the case) and select 

either “Install Driver” or “Update Driver”.  

Select the second, “Browse my computer for driver software” option. 
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Figure 4 Update spectrometer driver 

Enter C:\Program Files\Ocean Optics\OmniDriver\winusb_driver in box under “Search for drivers in 

this location:”.  Then click Next. 
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Figure 5 Install/update Ocean Optics driver 

 

1.3.4 GPS Driver 

The GPS that uses PL2303 driver, it can be found at http://prolificusa.com/pl-2303hx-drivers/ 

under Drivers & Softwares.  Click on the ‘Download’ link next to “Windows Driver Installer Setup 

Program”, unzip the file, and follow the instructions in How To Install USB Driver.pdf. 

It is also suggested that users install the GPSinfo program by running the GPSInfoSetup.exe found in 

the “GPSInfo Utility For Windows” folder.  You can use this program to see if your GPS driver was 

successfully installed and that your GPS is working. 

MobileDOAS supports NMEA 0183 protocol for GPS data output. 

1.3.5 MobileDOAS  

http://prolificusa.com/pl-2303hx-drivers/
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Create a directory, e.g. C:\\MobileDOAS, and place the MobileDOAS executable (i.e. MobileDOAS.exe 

or MobileDOAS_x64.exe) in it.  If there is a configuration file from previous version of MobileDOAS, 

i.e. cfg.xml1, copy it into this directory also. 

1.4 EXECUTION 

Click the MobileDOAS.exe to start the 32-bit version of the program.  

Click the MobileDOAS_x64.exe to start the 64-bit version of the program. 

2. Configuration 

MobileDOAS must be configured prior to collecting Spectra. Select menu “Configuration → 

Operation Setting” or click  on the toolbar to open the Configuration Dialog.  If cfg.xml exists in 

the working directory, the configuration dialog will read the existing configurations and allow the 

user to edit them. If cfg.xml does not exist, then it will warn the user that one does not exist. The 

software will have to be configured through the dialog. 

The dialog contains four tabs: 

• Spectrometer – Configure spectrometer connection and exposure time of spectra. 

• GPS – Configure GPS port and baud rate. 

• Evaluation – Configure how to evaluate the collected spectra. 

• Directory − Configure real-time analysis from directory. 

When you are done configuring the settings, press the button “Save” to store the settings to cfg.xml 

or press “Cancel” to close the dialog without writing anything to file. 

2.1 SPECTROMETER 

 

1 MobileDOAS version 4.4 and below used cfg.txt as configuration file.  If you are upgrading from these older 

versions, it is recommended that you create cfg.xml using the configuration dialog per section 2. 
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Figure 6 Spectrometer tab of Configuration Dialog 

This page is divided into the following groups: 

• Spectrometer Setting – Choose “USB” if an USB-cable is used for communicating with the 

spectrometer. If the “Serial-Connection” option is used, select the correct COM port and 

baud rate for the spectrometer. Then select the number of channels that you wish to use on 

the spectrometer.  If the spectrometer supports it (e.g. QE65000), you can also specify the 

set point for the CCD temperature.  

“Directory polling” is a special option that will perform real-time analysis by looking for 

spectrum files in a directory.  This option is used when the spectrum are acquired outside of 

MobileDOAS software.  If this option is selected the N Channels and Set Point Temperature 

options are ignored.  Only 1 channel is supported in this mode. 

• Exposure Time – It is possible to set the exposure time manually or let the program 

calculate it automatically from the received level of light. 

o Fixed You can manually set the exposure time to use in the measurement with this 

option. This exposure time will be used for every collected spectrum in the 

measurement. 
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o Automatic (recommended) If this is set, then the exposure time will be calculated 

when the sky spectrum is collected, in the beginning of the measurement. This exposure 

time will then be used for every collected spectrum in the measurement. The calculation 

is based on the values in the two edit boxes. The first specifies pixel on the 

spectrometer’s detector where the light-level will be measured. The second is the 

desired saturation ratio at that pixel. 

o Adaptive (advanced users only): It is also possible to let the software calculate the 

optimal exposure time for each spectrum in the measurement. This gives better quality 

spectra but requires a stable temperature of the spectrometer. Notice that when 

selecting adaptive exposure time, the program will start the measurement by collecting 

a dark-current and offset spectrum – which can take 5 to 10 minutes. 

• Offset Removal. The software calculates and subtracts an offset from each spectrum with 

the purpose of reducing stray light and compensate for a changing offset. These values 

should be a range of pixels which you know should be dark (i.e. covering wavelengths 

where there really is not supposed to be any light). If you are using a S2000 or USB2000 

spectrometer covering the wavelength range 280 to 420nm then these values should be 50 

and 200. 

• Audio. To make it easier to make measurements alone, the software can play a sound for 

each measured column with increasing pitch (or volume if pitch is not supported by audio 

device) for high measured gas columns. The value to enter under ‘Maximum expected 

column’ is the maximum value that you expect to have in a measurement. Measured values 

at this column or higher will be played at the maximum pitch or volume. 

2.2 GPS 
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Figure 7 GPS tab of Configuration Dialog 

If you use GPS receiver, the checkbox of “Use GPS Receiver” should be clicked. The COM port and 

baud rate (usually 4800 bps) should be chosen according to the GPS receiver. Note: if the GPS is not 

used then no flux can be calculated from the measurement! 

If you are unsure of how to configure the GPS, go to “Control->Test the GPS” menu item.  It will tell 

you the COM port and baud rate if one is connected: 

 

Figure 8 Pop-up from GPS test 

2.3 EVALUATION 
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Figure 9 Evaluation tab of Configuration Dialog 

In this tab you will select the parameters for the evaluation of the measured spectra.   

2.3.1 Fit Window 

The Fit Window box lists the real-time DOAS analysis routines that are configured. Typically, only a 

single DOAS analysis for evaluating SO2 will be configured, and this box will only have one entry. 

This analysis will be performed on each spectrum as it is acquired, and the results will be displayed 

by the software as the measurements are taken. If desired, additional DOAS analyses can be set up 

by right-clicking in the box and selecting ‘Insert’. For example, an analysis for bromine monoxide 

(BrO) could be configured that would then also run in real-time as the data is acquired. 

2.3.2 Fit Parameters 

You should first specify the range of pixels to use for the evaluation, this is done in the two edit 

boxes ‘Fit From’ and ‘Fit To’. 

2.3.3 Misc 

Currently it is not possible to specify separate evaluation parameters for more than one channel.  

Users should leave this as the default value of ‘Master’. 

2.3.4 References 
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To derive gas column densities from the measured spectra, the absorption cross-sections of various 

trace gases are fit to the differential optical depth acquired during the measurement. Here, the 

reference absorption cross-sections that will be used in the fit are listed.  

Each reference cross-section is specified by a separate file. The reference files are simple ASCII files 

that either have a *.txt or a *.xs extension. Each file must contain the same number of lines as the 

spectrometer has pixels. The file can have one or two columns separated by a tab. If the file has only 

one column, the number in that column lists the differential absorption cross-section of the 

respective trace gas in units of  –2.5e15 cm2/molecule at the wavelength of the corresponding 

spectrometer pixel. If the file has two columns, the first column lists the wavelength of the 

respective pixel in nm, while the second column lists the differential absorption cross-section.  

The supplied absorption cross-sections must be prepared individually for each spectrometer and 

take into account the spectrometer’s instrument line shape and optical resolution. This is typically 

done by convolving a high-resolution absorption cross-section with the instrument line shape, 

which is in turn determined by measuring a mercury vapor lamp. This process is somewhat 

complex, and if you are uncertain of which reference file to use, ask the supplier of your mobile 

DOAS system. 

In order for the evaluation to work, at least one reference file must be specified. If you have not 

specified any reference files (that is; you don’t see anything in the box with references) then press 

the ‘Insert Reference’ button in the lower part of the page. This will open a dialog that makes it 

possible to select a reference file to use. If you wish to change the setup, then select the reference 

file you wish to remove in the list and press the button ‘Remove reference’. You can specify any 

number of references that you wish in the list of references but only the fit result of the first one 

will be shown on the screen when making a measurement. 

To see the options for a reference, select the reference in the list and press the ‘Properties’ button. 

This will show the dialog seen in Figure 10. It is here possible to change how the given reference file 

will be used in the fitting. For example, you can specify a constant or variable shift and/or squeeze 

of the reference in wavelength space.  
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Figure 10 Reference Properties dialog 

 

You can check the reference files that you have specified by pressing the button ‘View’, this will 

open the reference file window. In this window you can see the size of the reference files over the 

range of pixels specified by “Fit From” and “Fit To”. If you don’t see any red line in the graph, then 

you should check your reference files. 

 

Figure 11 Reference File view window 

Click “Save” to save the new configuration or “Cancel” to close the dialog without saving anything. 
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2.4 DIRECTORY 

MobileDOAS can view and analyze spectra collected externally by watching a directory for new 

spectrum (.std) files.  This feature is enabled by selecting the ‘Directory polling’ option in the 

Spectrometer settings.  The Directory tab are configurations used in this mode.  The “directory to 

watch” is where the software will look for spectrum files.  Since MobileDOAS is not directly 

connected to a spectrometer, the dynamic range of the spectrometer must be specified.  If there are 

no files in the directory to watch, it will sleep for the number of milliseconds specified in the ‘Time 

in ms to sleep…” setting.   

 

Figure 12  Configurations for real-time analysis from a directory  

When this mode of collection is started, it first looks for starting files in the directory specified in 

the “Directory” tab of the configuration dialog. For automatic and fixed exposure time modes, the 

program requires sky (sky_0.std) and dark (dark_0.std) files.  If the files are in the watch directory 

when collection is initiated, it will use those files.  Otherwise it will use the default files specified in 

the “Directory” configuration.  For adaptive mode, the program will similarly look for sky, darkcur 

(darkcur_0.std), and offset (offset_0.std) files.  After the required files are read, the program will 

check the watch directory for normal spectrum files (e.g. 00001_0.std).  If a file is found it will read 

the file, analyze it, and plot the spectra and column.  After a file is processed it will wait X 

milliseconds, where X is the value specified for sleep time in the configuration, and check the 
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directory for a new file.  During each check, only the newest spectrum file is read and plotted. 

Whenever a new file is not found, it will wait and periodically check the directory for it.  

 

3. Performing Flux Measurements Using MobileDOAS 

To perform a flux-measurement using MobileDOAS ensure that the equipment listed in section 1.1 

is connected to a computer running MS Windows and has been configured as described in section 2. 

3.1 COLLECTING SPECTRA 

3.1.1 STEP 1 - Verify Configurations 

Prior to each collection, double check the configurations previously created through the 

Configuration Dialog (see section 2.) 

3.1.2 STEP 2 - Initial Setting 

After checking the configurations; set wind speed, wind direction, and base name for the 

measurement in the main window. The wind speed and the wind direction parameters are used by 

the real-time calculation of flux. So if you are not sure about the wind speed and the wind direction, 

you can leave them as the default values. 

The base name is the name you give to the measurement and is used when saving the spectra. 

 

 

 

 

Figure 13 Initial setting in the main window 

 

3.1.3 STEP 3 - Start Data Collection 

Click button “Start” (shown in Figure 13) or click  in the toolbar to start data collection. 

You can also start data collection by clicking menu “Control → Start Traverse”. 
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When the data collection starts, the program tests the connections to determine if the spectrometer 

and GPS are connected to the computer. The software creates a folder with the name of the current 

date (taken from the computer’s time) inside which all measurements will be stored, with one sub-

folder for each measurement performed.  

The measurement starts with setting the exposure time of the spectrometer and the telescope must 

therefore in the beginning be pointing to the zenith. Once the exposure time is set, the number of 

exposures to add before storing one spectrum is calculated based on the desired time-resolution 

and the calculated exposure time. The dark-current of the spectrometer detector is then measured 

at the set exposure time; to do this the entrance of the telescope must be covered. When the dark-

spectrum is measured, the program measures one “sky” spectrum, which is also sometimes 

referred to as Fraunhofer-reference or control spectrum. This is the reference spectrum to which all 

the evaluated column values will be relative, hence if this spectrum contains pollutants such as SO2 

then the evaluated column values can be negative. 

Each measured spectrum after the sky-spectrum is evaluated, using the dark and the sky 

measurements and the result is shown in the main-window and also appended to the evaluation log 

file in the output folder. The measured spectra, including the sky and the dark spectra, are also 

stored in the output – folder.  The program stores the collected spectra as STD-files and it creates 

one evaluation log containing the results of the evaluations. 

3.2 REAL-TIME RESULTS 

To make sure that the data-collection runs as it should, the MobileDOAS program shows running 

information which makes it possible to inspect the collection of data. 

3.2.1 The Main Window 

The main-plot in the main-window shows the evaluated columns of the last measured spectrum (by 

default as red columns), the intensity of the last spectrum (by default as white squares) and the last 

spectrum measured (by default as a green line for the master-channel of the spectrometer and as a 

red line for the slave-channel of the spectrometer, if one exists). 

In the lower part of the main-window, additional information about the collected spectra is shown. 

The ‘Spectrometer Information’ – panel shows the following information about the last measured 

spectrum 

• The exposure time, in milliseconds 

• The evaluated column and the column error, in ppmm 

• The shift used in the evaluation, normally 0 

• The number of spectra measured and saved so far 

• The number of exposures which are co-added in the last measurement 
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• The squeeze used in the evaluation, normally 1 

The ‘GPS-Information’ – panel shows the following information about the last reading from the GPS-

receiver: 

• GPS-time in UTC 

• Latitude in degrees 

• Longitude in degrees  

• # Satellites – the number of satellites that can be seen by the GPS-receiver. A minimum of 

three is required for the calculation of latitude and longitude. 

If the GPS – receiver loses the connection with the satellites, the ‘GPS-Information’ - panel will give 

a warning by turning red. 

3.2.2 Real-time route Graph 

The real-time route graph can be opened from the menu in the main window through the menu 

option ‘View -> Real-time Route’. If there is a GPS-receiver connected to system, then the real-time 

route window shows the location of the so-far collected spectra in a latitude-longitude plot. 

3.2.3 Spectrum Fit Window 

The Spectrum-fit window can be opened from the menu in the main-window through ‘View -> 

Spectrum Fit’. The spectrum-fit window shows the last differentiated measured spectrum together 

with a scaled cross-section provided from the given reference-file. This can be used to visually 

inspect the quality of the DOAS fit. 

3.2.4 Column Error 

The error bars of the retrieved columns can be shown in the real-time graph. The menu option 

‘View -> Column Error’ toggles the error bars on or off. The graph will be updated when the next 

spectrum is collected. 

4. Flux Calculation 

4.1 FLUX FORMULA 

The flux is calculated using the measured gas columns, the spatial distance between two sample 

points, the wind speed and the wind direction. The formula is: 

Flux = column * distance * wind speed* wind factor 

The wind factor is calculated by the travel direction and the wind direction: 

Wind factor = cos(travel angle– wind angle+ 3π/2). 
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The flux can be calculated in two ways, either in real-time directly from the measurement or off-line 

after the measurement has been done. The real-time calculation does not allow for any inspection 

of the data used and should only be used to give an indication of the size of the flux. 

4.2 REAL-TIME FLUX 

During the measurement you can check the real-time flux. Select the menu option “Control -> 

Realtime Flux”, the flux value will be shown. The real-time flux calculation uses the raw column 

values and the wind speed and wind direction that was given when the measurement started. 

4.3 CALCULATING FLUX FROM FILE 

After the measurement is finished you can calculate the flux using the post flux calculation dialog in 

MobileDOAS. click on the menu “Analysis -> Calculate Flux From File” or click on the button  on 

the toolbar to open the “Post Flux Calculation” dialog. 

 

 

Figure 14 Post Flux Calculation dialog 

4.3.1 STEP 1 – Set Wind Parameters and Source Coordinate 
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First open the evaluation log file from the measurement you want to process by pressing the button 

“Open Log File(s)” in the upper right corner of the dialog. The program will now read the data in the 

evaluation log file and show some data on the screen. 

In the small list-box just below the “Open Log File(s)” button you can see which log files are 

currently opened and select which one to process. The main graph in the dialog shows the columns 

from the currently selected measurement. Notice that when a measurement has been evaluated 

with several references (e.g. SO2 and O3) then this will be listed as two or more evaluation logs – 

each one starting with the name of the trace gas. Make sure that you select the trace gas you wish to 

calculate the flux for! 

To calculate a flux, you need to fill in the wind speed and wind direction (in degrees) at the time of 

the measurement in the white boxes below the evaluation log list. 

MobileDOAS can also calculate a wind direction for you. If you wish use this feature, then you need 

to supply the latitude and longitude of the source. The wind direction is then calculated as the 

direction of the line directly from the source to the point where the center of the gas plume is found. 

 

Figure 15 Post Flux Calculation Wind Settings 

Note: There is one line for every reference that was included in the evaluation of the spectra. Be 

sure to select the specie you wish to calculate the flux for. 

The wind speed and wind direction can also be imported from a text-file, see section 4.4. 

4.3.2 STEP 2 – Delete Bad Points 

Check the column plot to see whether there are any “bad points”. The “bad points” are spectra with 

very low or very high intensity and are usually caused by trees or buildings which are blocking the 

light to your telescope during the measurement or by bright clouds sending too much light into the 

telescope. In below example, several measurements have very low intensity caused by trees 

blocking the light.  The intensity of each spectrum are plotted as white squares and the error in the 

derived gas columns. 
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Figure 16 Example of readings with bad measurements 

If you cannot see the white squares use the menu-item ‘View -> Show Intensity’ or right-click on the 

graph and select ‘Show Intensity’ to show the white squares. You can also see the error of each 

derived gas column in the plot by selecting ‘View -> Show Column Error’ or right clicking in the 

graph and selecting ‘Show Column Error’. 

A “bad point” can be either a very low or very high concentration value, which introduces very large 

errors into the flux calculation. 

The “bad points” can be deleted in two ways: 

• By index: Use the “From” and “To” sliders to enclose the location of the “bad point”, note 

that points which are not in the selected range will be grayed out. The indices at which the 

‘From’ and ‘To’ sliders are pointing is shown to the right of each slider. Clicking the button 

“Delete Selected” will delete the points between the two sliders. 

• By intensity: Use the “Intensity” sliders on the left hand side of the window to define a limit 

on the intensity of the spectra.  When you click the “Filter” button all measurements with 
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intensity lower and higher than the defined thresholds will be deleted and a message box 

will inform you of the number of points deleted. 

Below image shows the data from Figure 16 after deleting bad points and filtering on intensity. 

 

Figure 17  After deleting points 

4.3.3 STEP 3 – Calculate Flux 

Move “From” and “To” sliders to enclose the scope where you want to calculate flux. If the traverse 

is very long, not all measurements will be shown in the plot. You can then move the plot using the 

 buttons. Move the “Offset” slider to set the column offset for flux 

calculation. Usually the offset value can be set to the lowest column value. Select the unit you want 

to have the flux in then click the button “Flux = ” to get the flux result. After the calculation the 

program generates a log file called fluxCalculation.txt which locates in the same place with the 

evaluation log file. 
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4.4 IMPORTING A MODELED WIND FIELD 

In cases where the traverse extends over a larger area a modeled wind field can give a more 

accurate result. The modeled wind fields can provide a different wind speed and wind direction for 

each measurement point. To import the result from a model, first open the evaluation log for which 

the flux shall be calculated in the post-flux dialog.  Then select ‘Edit -> Import Wind field’ from the 

menu. This will open the ‘Include Wind Field’ dialog below.  

 

 

Figure 18 Include Wind Field dialog 

The text-file containing the modeling can be selected by pressing the ‘Browse’ – button. If the file 

contains data for several altitudes and times, then the two combo-boxes in the left side of the dialog 

will contain all altitudes and hours for which the data is valid. Selecting a combination of one 

altitude and one hour will display the wind-field in the graph in the ‘Include Wind field’ dialog. The 

wind field is displayed as lines pointing to the direction in which the wind comes from and the 

relative length of each line shows the strength of the wind at that point compared to the other 

points. Finally, pressing the ‘Use’ button in the lower part of the dialog will import the data from the 

wind-field to the currently selected evaluation log. 

Note: 
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• Only the data for the altitude selected in the ‘Altitude’ combo-box will be used. 

• The time of the measurement will be compared to the time of the data points in the wind 

field and the correct time will be chosen automatically. 

• If a measurement point does not exactly correspond to any point in the wind field file then 

the closest point will be selected. 

• The time-stamp for each wind data-point can only be an integer hour. Measurements made 

in between two integer hours will be interpolated in time. E.g. for a measurement made at 

13:25 the wind field will be a linear interpolation between the wind-field at 13:00 and at 

14:00. 

For a detailed description of the format of the files that can be imported, see section 13.  

5. Re-Evaluation of Spectra 

If the real-time evaluation of the spectra was not adequately good, the spectra can be evaluated 

again by using the spectrum ReEvaluation module of MobileDOAS. There are many options for how 

to re-evaluate a measurement. The options are organized into tabs in the ReEvaluation dialog. For 

most re-evaluations, the values already filled in when the dialog is opened are ok. 

The ReEvaluation-dialog is reached by: 

• The menu in the main-window by selecting ‘Analysis -> ReEvaluate Traverse’ 

• By pressing the button  on the toolbar 

5.1 STEP 1 – SELECTING THE EVALUATION LOG 

The first step is to select the evaluation log from the performed measurement. The evaluation log 

should stay in the same directory as where it was created, i.e. in the same directory as all the 

spectra in the measurement. The evaluation log is selected by pressing the ‘Browse’ button in the 

‘Evaluation log’ top part of the dialog, as shown in Figure 19. When the evaluation log is correctly 

opened, the measured columns in the log-file will be shown in red in the plot in the lower left part 

of the dialog. 
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Figure 19 ReEvaluation dialog 

It is possible to view the spectra in the measurement by pressing the button ‘View Spectra’, more 

about this in section 6.1. 

There are several groups in the first page, their function is as follows: 

5.1.1 Dark Spectra  

Here it is possible to select if some spectra shall not be evaluated. For example, spectra with very 

low intensity will give very bad values, and it can therefore be justified to ignore some 

measurement points already in the evaluation instead of removing them later, in the post-flux 

calculation. There are three options: 

• Ignore completely dark spectra. Only spectra where there is no light whatsoever will be 

ignored. 

• Ignore Spectra with Intensity below: Lets the user select the channel at which the 

intensity should be judged and a desired threshold intensity for ignoring spectra. 
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• Ignore the Following Spectra: If the user knows the indices of some spectra that should be 

ignored, their indices can be typed into the edit-box as a comma, or space separated list. 

5.1.2 Saturated Spectra  

Similar to the ‘Dark Spectra’ box above, but here the user can select to ignore spectra with too much 

light. Spectra with too high light-level are saturated and does not contain any information in the 

saturated regions. The user has here the possibility to specify a pixel/channel to judge the intensity 

and the desired maximum level of intensity that should be allowed at that pixel/channel. Saturated 

spectra will only be ignored if the checkbox is checked. 

5.1.3 Wavelength Range 

In the evaluation of a spectrum, the spectra will automatically be corrected for stray-light using a 

simple heuristic method. This correction is different if the spectrum starts in the deep UV-region or 

in the (near) visible region. Select the ‘UV’ – radio button of the spectrometer starts at a 

wavelength of 300 nm or less. 

5.2 STEP 2 – THE SKY SPECTRUM 

The measurement is evaluated using one spectrum as ‘sky’ reference. This spectrum is used to 

remove Fraunhofer structures in the measured spectra, and all evaluated values will be relative to 

this spectrum. The sky spectrum can be selected in several ways, and the different options will give 

different qualities of the resulting measurement value. 

• Use fist spectrum as sky reference – The default option, this is also the behavior for the 

real-time evaluation. 

• Use average of all spectra as sky reference – An average value of all spectra will be used 

as sky reference. This can improve the quality of the fit, if all spectra in the measurement 

are good. 

• Use the following spectrum: A specified spectrum will be used as sky-reference. This can 

improve or worsen the fit, depending on which spectrum is chosen. This can make it easier 

to compare several measurements. 
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Figure 20 Sky tab in the ReEvaluation dialog 

5.3 STEP 3 – THE FIT WINDOW 

The most important step in the ReEvaluation dialog is to select the parameters for the evaluation of 

the measured spectra. The settings here are similar to that of the Evaluation tab in the Configure 

dialog.  Refer to section 2.3 on usage. 
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Figure 21 The Fit Window tab of the ReEvaluation dialog. 

 

5.3.1 Storing Fit Window Settings 

When you have configured a set of parameters that works well for your spectrometer then you can 

save these settings to a file (so that you don’t have to type in the same things the next time). To do 

so select the menu option ‘Settings→Save Settings to File’ and select where to store the file. The 

next time you open the re-evaluation dialog these settings can be re-read from the file by selecting 

the menu option ‘Settings→Load Settings from File’. Notice that it is good to make sure that the 

settings actually work well for your spectrometer before storing them to file. This can be done by 

running the re-evaluation as described below and when this is done (and all looked fine) select the 

menu option ‘Settings→Save Settings to File’. The stored files will have the file extension of ‘rxml’. 

5.4 STEP 4 – RE-EVALUATING 

The final page in the ReEvaluation – dialog is the ‘Do Evaluation’ – page. Pressing the ‘Evaluate 

NOW’ button will cause the program to evaluate all the spectra in the measurement using the 



34 

 

chosen settings. The spectral fit of each evaluated spectrum will be shown in the graph in the upper 

right part of the page, and any messages will be shown in the text-box in the upper left part of the 

page. 

 

Pressing the ‘Pause’ – button will cause the re-evaluation to make a pause after the evaluation of 

each spectrum, to enable visual inspection of the fit. The fit will continue after pressing the ‘Next…’ 

button, which replaces the ‘Evaluate NOW’ button. 

Pressing the ‘Cancel’ – button to the right of the ‘Evaluate NOW’ button will cause the program to 

stop the ReEvaluation. 

Note – do not press the ‘OK’, ‘Cancel’ or ‘Close’ buttons in the lower right part of the dialog when 

spectra are evaluating. 

 

Figure 22 Do Evaluation tab in Evaluation dialog 



35 

 

5.5 SCRIPTING THE RE-EVALUATION (ADVANCED)  

If you have a large set of MobileDOAS measurements that you need to ReEvaluate then the 

possibility to create ReEvaluation scripts can prove useful. You need to prepare this by saving the 

settings in the fit window page to file (see section 5.3.1). The scripts are created through the 

ReEvaluation Script dialog which is accessed from the ReEvaluation dialog by the menu option 

‘Script→Create Script’, this opens the dialog shown in Figure 21. 

 

Figure 23 ReEvaluation Script dialog 

Begin by selecting the file containing the settings from the fit window page by pressing the button 

‘Browse’ and select the RXML – file created earlier. You then need to specify the evaluation logs 

from the measurements you wish to re-evaluate. There are two ways to do this; 

1) Press the ‘Insert Evaluation Log’ button and select an evaluation log file that you wish to 

process. Press this button again for each evaluation log file you wish to include. 

2) Press the ‘Scan for log files’ button and select a directory. This will scan the directory 

structure for evaluation log files and automatically insert all evaluation log files in all sub-

directories to the one you chose. 
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You can always remove an evaluation log file from the list by selecting it in the list of files and 

pressing the button ‘Remove Evaluation Log’. 

When you are happy with your settings, press the button ‘Save Script’ in the bottom of the dialog to 

store the script to file. The file is given the file-ending .rs. You can later open this script again by 

opening the same dialog and selecting the menu option ‘File→Load Script’. 

To run a ReEvaluation script, go to the ReEvaluation dialog and select the menu option ‘Script→Run 

Script’. This will automatically start the re-evaluation of the spectra and the results of the spectral 

fitting will be shown in the graph in the ‘Do Evaluation’ page. Notice that it can take a very long time 

for the script to finish. 

6. Other Measurement Modes 

6.1 VIEWING SPECTRA DIRECTLY FROM THE SPECTROMETER 

Sometimes it is useful to be able to view spectra directly from the spectrometer without saving the 

spectra, e.g. when checking the light level, adjusting the optics of the instrument or checking that 

the fiber is not damaged. There is a special measurement mode in MobileDOAS which does this, to 

start this click “Control→View Spectrometer Output” in the main menu or click the button  in 

the toolbar. This will open two new windows, as can be seen in Figure 22. 

In this measurement mode are spectra continuously collected using the settings that are found in 

the “Spectrum collection settings” window. To exit this mode, press the stop button in the toolbar 

or close the program. 

The window “Spectrum collection settings” allow you to change the exposure time that is used 

when acquiring spectra and the number of spectra that are averaged together. If more than one 

spectrometer is connected to the computer, you can also select which spectrometer should be used. 

Pressing the button “Save spectrum” allows you to save the last acquired spectrum (the one shown 

on the screen). 

The window “Spectrum scale” modifies the scaling of the plot. 
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Figure 24 Real-time spectra viewing 

7. Other Functions 

7.1 VIEWING COLLECTED SPECTRA 

It is possible to view the spectra collected in a measurement by opening the Spectrum Inspection 

Dialog. This can be found by either: 

• Clicking on the menu option ‘Analysis→View Measured Spectra’ from the menu in the main 

window. 

• Opening the ReEvaluation dialog, selecting an evaluation log file and pressing the ‘View 

Spectra’ button. 

In this dialog you can select an evaluation log file by pressing the ‘Browse’ button. Once the 

evaluation log file is opened you can see each of the measured spectra and the properties for each 

single spectrum. The spectra can be browsed through by moving the slider bar just above the 

spectrum graph. Notice that the evaluation log file must be in the same directory as the 

measured spectra. 

It is possible to zoom in the spectrum by clicking and dragging with the left mouse button in the 

graph. Clicking the right mouse button will restore the zoom level to its original value. 
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Figure 25 View Collected Spectra dialog 

7.2 THE ROUTE DIALOG 

You can see a plot of the route traversed during a measurement by first opening the measurement 

in the Post Flux Calculation dialog then pressing the menu option ‘View→Show Route Map’ or by 

right-clicking in the graph and clicking the menu option ‘Show Route Map’. The route graph shows 

the position for each measured spectrum on a square latitude-longitude plot. The start point of the 

traverse is marked with a big green square 

The graph can also show the position of the source as a red square if the check button “Show 

Source” is checked and a latitude and longitude is typed into the “Lat” and “Lon” boxes. 
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Figure 26 Route dialog opened from Post Flux Calculation dialog 

On the right hand side in the window there is are three radio buttons in the “Display” section. 

Checking the radio button “Column” will make the graph show the measured column values using a 

color range varying from blue as the lowest values ranging to red as the highest values. Using the 

radio buttons the plot can also be made to show the Column error or the altitude of the 

measurement, on a relative scale. 

 

7.2.1 View Options 

In the menu ‘View’ found in the route dialog there are many options for how to draw the graph, e.g. 

can the column values in the graph be shown either by color (with blue indicating the lowest values, 

and red as the highest) or by size of the squares (larger squares correspond to higher values). 

7.2.2 Zoom 

It is possible to zoom the graph by clicking and dragging the mouse cursor in the graph. Starting the 

click from the upper left corner and dragging the cursor to the bottom right corner increases the 
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zoom (i.e. zooms in).  Starting the click from the lower right corner and dragging the cursor to the 

upper left corner decreases the zoom (i.e. zooms out). The original zoom-level is restored by right 

clicking anywhere in the graph. 

7.2.3 Distance and Bearing Calculation 

It is possible to calculate the distance and bearing between any two points on the graph. Start by 

pressing the “Calc. Bearing and Distance” button on the right. The program will tell you to click on 

the first point in the graph. When clicking on the second point in the graph the program will tell you 

the distance and initial bearing between the two points. 

7.2.4 Landmarks 

To mark other points on the route graph, type in their latitude and longitude in the grid under 

‘Landmarks’. If a wind-field has been imported for the currently shown measurement, the direction 

of the wind at each measurement-point can be shown by marking the checkbox ‘Interpolated 

Windfield’ found in the ‘Display’ group on the right hand side of the dialog. The colors of the 

background, the grid and the lines displaying the wind-field can be changed. The entire plot can be 

saved to an image file from the ‘File -> Save Graph as Image’ menu. 

7.3 EXPORTING EVALUATED RESULTS TO GOOGLE EARTH 

The gas columns from a measurement with MobileDOAS can be exported to KML for viewing in 

Google Earth. This is done by opening the evaluation log file in the Post Flux Calculation dialog and 

selecting the menu option “File→Export traverse to Google Earth”. This will bring up a dialog 

asking for a file name and where to store the file. After pressing “Save” here another dialog will pop 

up asking for which scaling height to use in the file. The scaling height is the height that the highest 

column in the measurement will take, what value you should use depends on the terrain around the 

measurement and the size of the measurement. You can try this process several times with 

different scaling heights and try which one looks good for you. 
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Figure 27 Measurement made in MobileDOAS exported to KML and displayed in Google 

Earth 

7.4 TESTING THE GPS CONNECTION 

When using a GPS-receiver with USB-port that simulates a serial-port there can sometimes be an 

uncertainty of which serial-port contains the GPS-receiver. This can be tested by pressing 

‘Control→Test The GPS’ in the menu in the main-window. This will sequentially run through the 

serial-ports 1 to 10 and test each one for the presence of a GPS-receiver. When a GPS-receiver is 

found, the user will be informed of the name and number of the serial-port through a message-box. 

7.5 PLOT SETTING 

You can set the background color and the plot color. Choose “Plot Setting->Set Background Color” to 

change background color. Choose “Plot Setting->Set Plot Color” to change the histogram color. 

7.6 PAUSE AND EXIT 

 

Click  on the toolbar to pause the program. 
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Click  on the toolbar to exit the program. 

8. File Formats 

Software versions prior to 4.4 used cfg.txt as the configuration file. This file format has been 

deprecated and it is recommended that the configuration file is recreated using the latest version of 

MobileDOAS. 

MobileDOAS version 4.4 and higher uses cfg.xml as the configuration file. All versions of 

MobileDOAS are capable of reading the old file format (cfg.txt) however as from version 4.4 

MobileDOAS can only write the new file format (cfg.xml). 

8.1 PARAMETERS  

The configuration file consists of a number of parameter definitions and a number of sections. 

These are all described below. An example of a cfg.xml file can be seen in section 8.2. 

Parameter Description Scope Example 

serialPort The port ot use, normally USB but can also be any COM port. USB, 

COM1, 

COM2, … 

USB 

timeResolution Time between two consecutive spectra measurements in 

milliseconds. Used for the exposure time calculation. 

>500 5000 

nchannels Number of channels to use in the spectrometer 1 or 2 1 

maxColumn Beep volume = (current column/max column)*max volume  200 

 

8.1.1 Intensity Section 

The parameters described in the intensity section are used to determine the exposure time for the 

spectra. The parameters used are: 

Parameter Description Scope Example 

Channel The pixel around which to measure the intensity of the 

spectrum. 

1 to 2047 1150 
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Percent The desired intensity of the spectrum around the pixel 

specified by Channel in percent. 

0 to 100 80 

FixExpTime How to calculate the exposure time: 

0 – Automatic exposure time 

>0 – Fixed exposure time in milliseconds 

< 0 – Adaptive exposure time 

0 

 

8.1.2 GPS Section 

The GPS section defines how (and if) MobileDOAS should communicate with the GPS receiver. 

Parameter Description Scope Example 

use Use GPS receiver or not 1 – use GPS receiver; 

0 – do not use GPS receiver 

1 

baudrate The baud rate to use when communicating 

with the GPS 

1200 to 115200 4800 

Port The serial port to use when communicating 

with the GPS 

COM1, COM2, … COM4 

 

8.1.3 The Offset section 

The offset section defines how MobileDOAS should correct for the offset of the spectra. This feature 

enables a first level compensation for stray-light in the spectrometer but can also compensate for a 

changing offset level (for spectrometers which have a problem with this). 

If both from and to are set to 0 then no offset correction will be performed. 

Parameter Description Scope Example 

from The lowest pixel to use when calculating offset 1 to 2048 50 
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to The highest pixel to use when calculating offset 1 to 2048 200 

 

8.1.4 The Fit Window Section 

The fit window section defines how to evaluate the spectra that are collected in the measurement. 

There can be several fit windows defined, they must however differ either in the channel they use 

or in the name. 

The fit window section also contains a number of Reference-sections, each defining how to fit a 

single reference file to the spectrum. 

Parameter Description Scope Example 

name The name of the fit window Any string SO2 

fitLow The lowest pixel to use when performing the DOAS fit 1 to 2048 340 

fitHigh The highest pixel to use when performing the DOAS fit 1 to 2048 561 

spec_channel The channel on the spectrometer that this fit window is 

valid for 

0 or 1  0 

polynomial The order of the polynomial to include in the DOAS fit 0 to 5 5 

 

The parameters of the reference section: 

Parameter Description Scope Example 

name The name of the reference Any string SO2 

path The full path to the reference file, including 

directory and file name. 

Any string C:\spec\SO2_reference.xs 

gasFactor The conversion factor to convert from 

ppmm to mg/m2 

>0 (depends 

on the gas) 

561 
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shift The shift to apply to the reference when 

performing the DOAS fit 

 fix to 0.0 

squeeze The squeeze to apply to the reference when 

performing the DOAS fit 

 fix to 1.0 

  

8.2 EXAMPLE OF CONFIGURATION FILE 

<?xml version="1.0" encoding="ISO-8859-1"?> 

<!-- This is the configuration file MobileDOAS --> 

 

<Configuration> 

 <serialPort>USB</serialPort> 

 <timeResolution>1000</timeResolution> 

 <nchannels>1</nchannels> 

 <maxColumn>1500.00</maxColumn> 

 <Intensity> 

  <Percent>70</Percent> 

  <Channel>1144</Channel> 

  <FixExpTime>0</FixExpTime> 

 </Intensity> 

 <GPS> 

  <use>1</use> 

  <baudrate>4800</baudrate> 

  <port>COM3</port> 

 </GPS> 

 <Offset> 

  <from>50</from> 

  <to>100</to> 

 </Offset> 

 <FitWindow> 

  <name>SO2</name> 

  <fitLow>400</fitLow> 

  <fitHigh>628</fitHigh> 

  <spec_channel>0</spec_channel> 

  <polynomial>5</polynomial> 

  <Reference> 

   <name>SO2</name>      

 <path>C:\References\D2J2949\D2J2949_Master_SO2_HP500_PPMM.txt</path> 

   <gasFactor>2.66</gasFactor> 

   <shift>fix to 0.00</shift> 

   <squeeze>fix to 1.00</squeeze> 

  </Reference> 

  <Reference> 

   <name>O3</name> 

  

 <path>C:\References\D2J2949\D2J2949_Master_O3_HP500_PPMM.txt</path> 

   <gasFactor>1.99</gasFactor> 

   <shift>link to 0</shift> 

   <squeeze>link to 1</squeeze> 

  </Reference> 

  <Reference> 

   <name>RING</name> 

   <path>C:\References\D2J2949\D2J2949_Master_RING.txt</path> 
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   <gasFactor>2.66</gasFactor> 

   <shift>link to 0</shift> 

   <squeeze>link to 1</squeeze> 

  </Reference> 

 </FitWindow> 

</Configuration> 

9. Reference File 

The reference files should contain the differential cross section of 1 ppmm of a single specie of 

interest e.g. SO2 or NO2. 

The reference files that are used should be in ASCII format and contain only one or two columns. If 

the file contains only one column, then this should specify the magnitude of the reference cross 

section. If the file contains two columns then the left should specify the wavelength. 

The file can end with .txt or .xs. 

10. Spectrum File 

The program records all the spectra in the extended STD file format, which is a human readable 

ASCII – file format. 

• The sky spectrum is stored as sky.STD file. 

• The dark spectrum is stored in dark.STD file. 

• All other spectra are stored in STD files named with continuous numbers. 

If using multi-channel spectrometers, the spectra from the master channel will end with “_0.STD” 

and the spectra from the slave channel will end with “_1.STD”. 

11. Evaluation Log File 

The program generates the evaluation file in which evaluation results are stored. 

The beginning of the file is the copy of configuration. After that comes a table containing the GPS 

time, latitude, longitude, altitude (from the GPS), number of spectra averaged in each saved 

spectrum, exposure time of the spectrum (in ms), average intensity, column, column error and the 

name and path to the spectrum file. 

11.1 EXAMPLE OF EVALUATION LOG FILE 

***Desktop Mobile Program*** 

VERSION=6.0 

FILETYPE=evaluationlog 

BASENAME=test39 

WINDSPEED=8.000000 

WINDDIRECTION=0.000000 



47 

 

***copy of related configuration file *** 

SERIALPORT=USB 

GPSBAUD=4800 

GPSPORT=COM4 

TIMERESOLUTION=1000 

FIXEXPTIME=0 

FITFROM=400 

FITTO=628 

POLYNOM=5 

FIXSHIFT=1 

FIXSQUEEZE=1 

SPECCENTER=1144 

PERCENT=0.700000 

MAXCOLUMN=1500.000000 

GASFACTOR=2.660000 

REFFILE=C:\Users\Diana\Documents\VDAP\Gas\NOVAC 

Project\References\D2J2949\D2J2949_Master_SO2_HP500_PPMM.txt 

REFFILE=C:\Users\Diana\Documents\VDAP\Gas\NOVAC 

Project\References\D2J2949\D2J2949_Master_O3_HP500_PPMM.txt 

REFFILE=C:\Users\Diana\Documents\VDAP\Gas\NOVAC 

Project\References\D2J2949\D2J2949_Master_RING.txt 

 

***Spectrometer Information*** 

SERIAL=D2J2949 

DETECTORSIZE=2048 

DYNAMICRANGE=4096 

MODEL=ADC1000-USB 

 

 

#Time Lat Long Alt NSpec ExpTime Intens(Master)

 Master_Column_SO2 Master_ColumnError_SO2 Master_Column_O3

 Master_ColumnError_O3 Master_Column_RING

 Master_ColumnError_RING STD-File(Master) 

 

23:51:08 45.618945 -122.477610 89.0 270 3 395 0.000000

 0.000000 0.000000 0.000000 0.000000 0.000000

 C:\Users\Diana\git\MobileDOAS\x64\Debug\2018.01.04\test39_2018010

4_1550\00000_0.STD 

23:51:11 45.618945 -122.477610 89.0 270 3 395 0.000000

 0.000000 0.000000 0.000000 0.000000 0.000000

 C:\Users\Diana\git\MobileDOAS\x64\Debug\2018.01.04\test39_2018010

4_1550\00001_0.STD 

23:51:15 45.618945 -122.477610 89.0 270 3 395 0.000000

 0.000000 0.000000 0.000000 0.000000 0.000000

 C:\Users\Diana\git\MobileDOAS\x64\Debug\2018.01.04\test39_2018010

4_1550\00002_0.STD 

 

 

12. Flux Calculation File 

Flux calculation file (fluxCalculations.txt) is generated after the post flux calculation. It is located in 

the same directory with the evaluation log file that has been calculated.  
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12.1 SAMPLE CONTENT OF FLUX CALCULATION FILE 

524.547038 [ton/day] 

Processed file:  C:\Evaluation 

Logs\TEST05_20171202_0909evaluationLog_SO2.txt 

Processed time: 2017.12.21  15:01:24 

Wind Speed=10.000000 

Wind Direction=0.000000 

Source latitude=0.000000 

Source longitude=0.000000 

Column offset=-8.276690 

PlumeWidth=97 [m] 

TraverseLength=31155 [m] 

 

13. File Format to Import Modeled Wind-Field 

The MobileDOAS can import the results from meteorological models into the post-flux calculation 

in order to improve the quality of the calculated flux. The wind field is in plain ASCII for simplicity. 

The ordering is primarily on position, with one paragraph for each position. Each paragraph starts 

with the line: 

Lat=XX.XXXX Long=YY.YYYYYY 

 

The latitude is positive on the northern hemisphere and the longitude is positive in the eastern 

hemisphere. 

The following line is a header-line for the data-table for that position. The header-line should have 

the following format: 

Altitude Hour WD [deg] WS [m/s] Hour WD [deg] WS [m/s] 

 

Where the three strings ‘Hour WD [deg] WS [m/s]’ is repeated once for each time-stamp 

available for that altitude. Notice that each item is separated by tabs, except for the separation 

between the item (‘WD’ or ‘WS’) and their unit which are separated by spaces. 

 

The data-table is sorted with one altitude per line and three columns for each time-stamp. An 

example of a line in the data-table matching the above given header-line: 

98.07 21 140.58 10.85 22 147.84 11.36 
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The unit of the altitude is optional, this is only to give the data meaning to the user and is not used 

in the flux calculation. The unit of the wind speed must be meters per second and the wind 

direction must be in degrees. 

Each paragraph is followed by one or more empty lines, marking the end of the paragraph. There 

cannot be more than 24 time-values for each altitude (each accompanied with one wind direction 

and one wind speed) and no more than 50 altitudes for each measurement point.  

13.1 EXAMPLE OF A SMALL WIND-FIELD DATA FILE 

Lat=19.491840 Long=-99.015170     

Altitude Hour WD [deg] WS [m/s] Hour WD [deg] WS [m/s] 

28.55 21 136.77 9.35 22 144.89 9.74   

98.07 21 140.58 10.85 22 147.84 11.36   

192.71 21 143.82 11.06 22 150.58 11.62   

313.09 21 147.63 10.86 22 153.99 11.41   

Lat=19.493700 Long=-99.015380     

Altitude Hour WD [deg] WS [m/s] Hour WD [deg] WS [m/s] 

28.55 20 140.08 6.74 21 136.77 9.35   

98.07 20 143.00 7.73 21 140.58 10.85   

192.71 20 145.26 7.84 21 143.82 11.06   

313.09 20 147.86 7.66 21 147.63 10.86   

Lat=19.512640 Long=-99.014650     

Altitude Hour WD [deg] WS [m/s] Hour WD [deg] WS [m/s] 

28.54 21 140.11 8.86 22 147.05 9.92   

98.03 21 142.39 10.34 22 149.01 11.57   

192.61 21 144.40 10.57 22 151.06 11.82   

312.93 21 146.89 10.40 22 153.81 11.60   

 

 

14. Troubleshooting 
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All suggestions presented in this chapter aim to allow the users to solve the most common 

problems they may encounter. 

Communication problem, restart data collection 

Description The communication between the spectrometer and the computer does not work or 

the spectrometer has no power. 

Solution Check whether the serial cable is well connected and whether the spectrometer has 

power. 

Timeout 

Description The communication between the spectrometer and the computer does not work or 

the spectrometer has no power. 

Solution Check whether the serial cable is well connected and whether the spectrometer has 

power. 

Spectra are collecting 

Description You have clicked the “Start” button a second time. 

Solution This does not affect the operation of the program. 

First byte of transmission is incorrect 

Description The communication between the spectrometer and the computer does not work 

correctly. This only happens when communicating with the spectrometer through a 

serial cable. 

Solution Check the physical connection and restart the program. 
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Cannot handle more than X channels. Changed number of channels to 2 

Description You have specified too many channels in the configuration file. 

Solution This will change your settings to use only two channels. Next time change the 

settings before starting the program. 

A negative amount of channels defined in the configuration file. This does not make sense, 

will change number of channels to 1 

or 

Zero channels defined in the configuration file. This does not make sense, will change 

number of channels to 1 

Description You have specified an illegal number of channels in the configuration file. 

Solution Revise the settings and restart. 

There are no reference-files defined in the configuration file. Please check settings and 

restart. 

Description You have not specified any references in the cfg.xml file or there are errors in 

cfg.xml. 

Solution Check the settings and restart. 

Cannot open reference file: XYZ for reading 

or 

Cannot read reference file XYZ Please check the file location and restart collection 

Description One of the reference files specified in cfg.xml is in the wrong format, not readable or 

not existing. 

Solution Check the settings and restart. 
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There are X columns in the reference file. This programs wants reference files with one or 

two columns. 

Description One of the reference files specified in cfg.xml is in the wrong format. 

Solution Check the reference files specified in cfg.xml and restart. 

Length of the reference file is: X values. Cannot handle references with more than Y data-

points. 

Description One of the reference files specified in cfg.xml is too long. 

Solution Check the reference files specified in cfg.xml and restart. 

Could not open evaluation log file. No data was written! 

or 

Could not write log file: XYZ. Not enough free space? 

Description The evaluation log file could not be opened for writing. 

Solution Check that the disk is not full and that you have write access permission to the 

directory. (Attempt to make file manually to verify.) 

Could not create output directory. 

Description The output directory could not be created in the directory where MobileDOAS 

executable resides. 

Solution Check that the disk is not full and that you have write access permission to the 

directory. (Attempt to make file manually to verify.) 
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No spectrometer found. Make sure that the spectrometer is attached properly to the USB-

port and re-start the program. 

Description The program could not contact the spectrometer. 

Solution Check that the spectrometer is plugged in. If it is then unplug it, wait a little and plug it 

in again to see if it helps.   

Cfg.txt specifies 2 channels to be used but spectrometer can only handle one. Changing 

configuration to handle only one channel. 

Description The configuration specifies that two channels are to be used but the spectrometer only 

has one. 

Solution Check cfg.xml and restart. 

Fit exception 

Description The evaluation procedure is not correct. 

Solution Check that the reference file is correct, that the fit range is valid and that you have not 

specified the same reference file twice in a fit window. 

Failed to initialize spectrometer 

or 

NAK1 

or 

TimeoutX  

Description This can happen when using the serial port to communicate with the spectrometer. 

Either a failure in the serial cable or in the power supply to the spectrometer. 

Solution Check the physical connection to the spectrometer, check that the spectrometer has 

power and restart the program. 
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Could not communicate with GPS. No GPS-data can be retrieved! 

Description The communication with the GPS failed for some reason. 

Solution Stop the program. Check the physical connection to the GPS receiver, check that the 

correct baud rate and serial port has been entered in the settings. 

Illegal GPS-Port. No GPS-data can be retrieved! 

Description The serial port for the GPS receiver that is specified in the configuration does not exist 

on this computer. 

Solution Check the settings and restart. 

It seems like the dark spectrum is not completely dark, consider restarting the program. 

Description MobileDOAS tries to judge if the collected dark spectrum is actually dark. 

Solution Look at the dark-current spectrum that is drawn on the screen (typically in green). If 

this is not a dark spectrum, then restart the program and try again. If this is a dark 

spectrum then you can continue the measurement. 

It seems like the sky spectrum is dark, consider restarting the program 

Description MobileDOAS tries to judge if the collected sky spectrum has enough intensity to be 

useful. 

Solution Look at the spectrum that is drawn on the screen (typically in green). If this indeed has 

too little light, then restart the program and try again. If this is an ok spectrum then 

you can continue the measurement. 
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Length of the reference file is: X values. Cannot handle references with more than Y data-

points. 

Description One of the reference files specified in cfg.xml is too long. 

Solution Check the reference files specified in cfg.xml and restart. 

 


